
NEWSLETTER #95 - October 2020

It ’s another bumper edition with all sorts of Excel, Power BI and financial 
modelling articles to read.  I can’t keep up – and I edit them!

This month, we look at how you can get at Excel’s syntax easily, plus new Excel features such as Save As Picture and auto-detecting 
Data Types.  There is important news about Power BI Desktop and Windows 7, plus there is a free Microsoft download to play with if 
you fancy your chances with the stock markets (definitely interesting given the current world economy!).

We also have our monthly regulars Beat the Boredom, Visual Basics, Power Pivot Principles, Power Query Pointers, Power BI updates 
for Desktop, Service and Mobile, plus we face the FACT that the A to Z of Excel Functions is continuing and even there 
are the usual Keyboard Shortcuts too (we show you how to keep CTRL of your functions…).

Happy reading and remember: stay safe, stay happy, stay healthy.

Until next month.
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Liam Bastick, Managing Director, SumProduct

A is for Assistance
Now we know we have an entire section of the newsletter dedicated to 
keyboard shortcuts, but every now and then we get a tip we hadn’t come 
across before that we think is worth highlighting – and this is such a case.

For example, imagine you wanted to get acquainted with a little-known 
and infrequently used function such as, say, VLOOKUP.  If you were to 
start typing the formula into a cell, you would see

Tiny image, we know, but Microsoft never thought to wrap text in its screen tips!

If at this stage, I were to press TAB,

the function name would autocomplete, together with the opening parenthesis (that’s the posh word for bracket).  At this stage, whilst still in Edit 
mode, if I were to press CTRL + A, 
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I would get the ‘Function Arguments’ dialog which could help me complete my formula.  OK, you may or may not have known this (we did), but there 
is an alternative that fellow Excel MVP Nabil Mourad filled us in on.  Instead of using the keyboard shortcut CTRL + A, look what happens if I were to 
execute CTRL + SHIFT + A instead:

The function syntax is now displayed in the cell.  We think that’s quite a clever trick, which could be useful when attempting to explain a function to 
a colleague.

It should be noted that these tricks don’t work with all functions (e.g. the usual suspects such as DATEDIF and EVALUATE are immune) and may 
require an interim step where alternative syntax is available (e.g. AGGREGATE or INDEX) – but hey, a cool trick is still a cool trick!

Save As Picture
Now this one is a bit of an interesting curiosity.  Indeed, I have been 
saving images from Word and PowerPoint as pictures for years, 
but you have not been able to do the same thing in Excel.  Granted, 
it was possible by simply copying an pasting into a graphics editor  
(e.g. Paint) and choosing a graphics file format (please see https://
support.microsoft.com/en-us/office/save-a-chart-as-a-picture-
254bbf9a-1ce1-459f-914a-4902e8ca9217 for more details).

However, unannounced by Microsoft, Microsoft 365 Beta / Insider 
/ whatever it’s called this week has a new option in Excel for charts, 
shapes and SmartArt – Save as Picture.  Simply right-click on the item in 
Excel and select the option from the shortcut menu, viz.

The default option is to save as a .png file, but other standard formats 
are available too.  It’s worth noting that the chart export is based upon 
the zoom level.  Therefore, it’s worthwhile temporarily setting the zoom 
to maximum (400%) before saving, so you get a higher resolution. 

The one thing missing is copying data as a picture!  You can use Excel’s 
camera tool, but there is another alternative.  First, copy your data in 
the usual way:
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Then, go to ‘Paste Special…’ and paste as a picture (ALT + H + V + U + ENTER):

Once you have it pasted, you may right-click this image and Save as Picture, as before.

Simple trick!
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Auto-detecting Data Types

New investment tracking template using Data Types and the STOCKHISTORY  
function

Here’s a new one.  As regular readers will know, Data Types such as 
Stocks and Geography have been available for a while, but many users 
simply aren’t aware of their existence.  That’s about to change.  Excel is 

going to get more bolshy and let users know when they have data in their 
workbook that could be enhanced by Data Types which will help users 
pull in external data to enhance the data they’re analysing.

To see it in action, imagine you typed in several geographic locations or 
stock ticker symbols and put them in a columnar format (i.e. listed them 
in a column). For example, “Sydney”, “Tokyo”, “London” or “MSFT”, 
“ADBE”, “GOOG”.

A ScreenTip will appear (either Convert to Geography or Convert to 
Stocks, depending upon what you typed).  All you have to do is click on 
that ScreenTip as it appears to the right of the selected cell.

It should be noted that for the moment, auto detecting in Excel is only 
available when an English input language is installed, and even then you 
have to have the right version of Excel.  Currently, this feature is available 
to Current Channel (Preview) users who are running Version 1911 Build 
11326.10000 or later.

Microsoft has just released a new investment tracking template out into 
the wild.  You can use it for automatically fetching and tracking investment 
data such as stock prices and history and it may be downloaded from 

here: https://go.microsoft.com/fwlink/?linkid=2141359&clcid=0x409.  It 
uses both the Stocks Data Type and the STOCKHISTORY function.
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Once you have downloaded and opened the spreadsheet, you land on the ‘Welcome’ worksheet.

Here, you may change the Theme settings: if you prefer a darker look, you can set it to Dark theme. The entire template will transition be as black 
as my mood. 

This sheet also explains how you can add or replace stocks, which may be identified using tickers or company names.

The ‘Portfolio’ sheet is the main sheet, where you enter your investments and shares to see their current values.  You can quickly see the price and 
current day results.  

A sparkline shows you the history in the row, and you can adjust the day’s value to see more. For example: change it to 180 to see around six months 
of history. 
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As you scroll the sheet, you’ll see additional information such as previous 
close and industry.  You can also see a 52–week high and low and a visual 
that shows you how close each stock is to its high and low. 

The ‘Dashboard’ sheet shows some of the aggregations from the Portfolio 
sheet, as well as a breakdown of the overall investments and categories. 

The ‘Watch’ sheet provides information about the company and what it does, as well as flag if a stock is within a set percentage of its 52 week high 
or low. 

The final sheet, ‘Compare’, displays all the details for a stock and put it side by side with another stock to compare price, price history, trend, volume, 
market cap, etc. 
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If you don’t have these features available yet, please note the following requirements:

	 •	Data Types require a Microsoft 365 subscription
	 •	 The new Data Types are only available to the Consumer audience in English-speaking markets
	 •	 The feature is rolling out to Insiders between now and the end of October, and will be available to users running: 
			   o	 Windows: Version 2007 Build 13029.20006
			   o	 Mac: Version 16.40 Build 20062901. 

Newsflash: Office Next

The Microsoft Exchange Team has just announced that Microsoft 
Office will also see a new perpetual release for both Windows and 
Mac, in the second half of 2021.  Details are scant, but check out 

https://techcommunity.microsoft.com/t5/exchange-team-blog/
exchange-news-and-announcements-microsoft-ignite-2020-edition/ba-
p/1662224 to confirm we aren’t lying to you…

Beat the Boredom Challenge
With many of us currently “working from home” / quarantined, there 
are only so Zoom / Teams calls you can make before you reach your data 
limit.  Perhaps they should measure data allowance in mugs of coffee.  To 
try and keep our readers engaged, we will continue to reproduce some 

of our popular Final Friday Fix challenges from yesteryear in this and 
upcoming newsletters.  One suggested solution may be found later in this 
newsletter.  Here’s this month’s…
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Not everything revolves around LET functions, dynamic arrays, XLOOKUP, VBA, Power BI, et al.  Sometimes problems are more rudimentary and 
occasionally, in this series, we will highlight such challenges to encourage you to think outside the box or remember your studies from yesteryear.

This one is such an example.

In  a recent financial model build, we needed to work out how much of a certain product was sold, which reduced each period, based on two 
multiplicative factors.  Over the life of the project, the proportion that needed to be considered was:

In Excel, I just needed to sum this as efficiently as possible – returning the 
total as a fraction in its simplest form.

This month’s challenge is to create an Excel spreadsheet that can 
calculate the result and be sufficiently flexible to allow for alternative, 
similar sequences of varying length.  No dynamic arrays, no VBA, no 

megaformulae.  In fact, for those readers with children, you might find 
they do better at this than you do…

Sound easy?  Try it.  One solution may be found later in this newsletter 
– but no reading ahead!  

Visual Basics
We thought we’d run an elementary series going through the rudiments of Visual Basic for Applications (VBA) as a springboard for newer users.  This 
month, we consider just how well you can hide...  

If something is hidden, it’s hard to see.  Therefore, if something is very 
hidden, it must be very hard to see, right?  That’s the overall principle 
behind hiding sheets using VBA.  Let’s go over the basics.  

In normal Excel, a sheet is either Visible or it’s Hidden.  If you can see it at 
the bottom of the page, it’s Visible, and you can right click on the sheet 
name, click Hide, and this will classify the sheet as a Hidden sheet.  If you 

want, you can then unhide the sheet by right clicking on any sheet, click 
on Unhide, and this will pull up a list of the Hidden sheets and you can 
choose which sheet to make Visible again.  

Hence, if I ask you, how many sheets are there in the file in this screenshot 
below, you’ll be forgiven for saying that there are four sheets – three 
that are Visible, and one that is Hidden.
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However, there’s a third state of sheets that’s not actually accessible 
via the standard Excel User Interface (UI).  This state is known as Very 
Hidden.  When a sheet is Very Hidden, not only is it an affront to the 
English language and not visible in your list of sheets, it’s also not shown 
in the list of sheets when you click on ‘Unhide’.  Very hidden indeed! 

The only way to access a Very Hidden sheet is to go into the VBA Editor 
(ALT + F11).  On the top left-hand side of the screen, you’ll see the Project 
Explorer.  In here, you’ll see different files and add-ins that you have 
open, along with the relevant objects that they’re made up of.  Here 
you’ll see the answer to my earlier question – this file has 11 sheets!  
Click on one of the sheets in any file you have open.

Just below the Project Explorer, you’ll see the Properties window.  This 
contains a number of key settings about the sheet, including the name, 
whether page breaks are visible, if calculations are on, and so on.  The 

property we’re most concerned about in this instance is the very bottom 
one – the Visible property.
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You can see in the screenshot that my sheet is currently selected to 
xlSheetVisible – the technical name for the Visible state.  You’ll see that 
there are two others though – xlSheetHidden and xlSheetVeryHidden.  
These are the two states that I described earlier – either Hidden and can 
be unhidden using the UI, or Very Hidden and only accessible via VBA.  
You can change the state of the sheet here in the Properties window, 
and that will immediately hide the sheet accordingly in Excel.

Therefore, if you ever want to hide a sheet in a slightly more secure way 
(people can always come into the VBA editor and check for themselves), 
then the Very Hidden sheet state is what you’re looking for.  

If we want to actually code this up, we’d use the following:

Sheets(“Sheet1”).Visible = xlSheetVisible

Sheets(“Sheet2”).Visible = xlSheetHidden

Sheets(“Sheet3”).Visible = xlSheetVeryHidden

If you couldn’t guess, this will set Sheet1 to be Visible, Sheet2 to be 
Hidden (and able to be unhidden using the UI), and Sheet3 to be Very 
Hidden, requiring users to get to it via VBA.

More next time.

Power Pivot Principles
We continue our series on the Excel COM add-in, Power Pivot.  This 
month, we look at multiple tables.

In our previous articles, we have created PivotTables that filter 
information for us.  However, in those PivotTables we only used 
information from a single table.  This time, we are going to build a 
PivotTable from multiple tables. 

In Excel it would be very difficult to code a PivotTable to draw data 
from more than one table; Power Pivot, on the other hand, can do this  
with ease. 

First things first, let’s ensure that our dataset has multiple tables.  From 
the ‘Home’ tab in the Power Pivot window we can navigate to the 
‘Diagram View’:  

We should then see a collection of tables:

Ensure that the tables have appropriate relationships established, by dragging and dropping the fields, as required.  Next, let’s head back to our Excel 
window and look at the ‘PivotTable Fields’ section: 
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There appears to be only one table here, even though we’ve linked all of the tables together.  Why don’t they appear?  This is a common query and an 
indictment on the user interface.  We have to select the ‘All’ option (it is annoying that Excel always defaults to ‘Active’, but it is trying to be “helpful”).

We can create a PivotTable with data from all of the tables in the list here.  Let’s start with the Sales from the ‘Sales’ table, and the 
EnglishProductCategoryName from the ‘Product Category’ table. 

We can also add in the Dates from the ‘Dates’ table.

As an added bonus, we can expand on the dates to view the breakdown based upon quarters and months:

More Power Pivot Principles next month.
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Power Query Pointers
Each month we’ll reproduce one of our articles on Power Query (Excel 2010 and 2013) / Get & Transform (Office 365, Excel 2016 and 2019) from  
www.sumproduct.com/blog.  If you wish to read more in the meantime, simply check out our Blog section each Wednesday.  This month, we look at lists.

This time out, let’s start with a nice simple example.  In a new query, we will create a list of consecutive numbers.

Curly brackets (or braces) { } indicate that a list is enclosed.  For whole numbers, we can define a range by giving my start and end points and separate 
them by an ellipsis of two dots (..) to indicate that the intervening numbers should be included.  Therefore, we may specify a list from 1 to 10 by 
entering

	 = {1..10}

in the formula bar.

Numbers are not the only list we may create with this format; we can create a list of consecutive letters.  Since letters are text, they must be 
surrounded by speech marks “ ”.
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Using ellipses with characters is limited to single characters though, so although we can create this list,

= {“0”..”9”}

We are not allowed to create this:

=  {“0”..”10”}

We have to specify the whole list instead:

=  {“0”,“1”, “2”, “3”, “4”, “5”, “6”, “7”, “8”, “9”, “10”}
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Therefore, lists with ellipses are more useful for numbers.  What if you want to create a list of dates without typing them out?  In this case, you can’t 
just type the number for the date as 15/11/17 or even 151117, as this is not how Power Query will recognise it.  However, we may use the serial 
number of the date.  In order to get a date in serial number format, we can use the Number.From function:

Number.From(value as any, optional culture as nullable text) as nullable number

The value is #date and we need to give the date as a year, month and day separated by commas.  Therefore, one such example would be:

= Number.From(#date(2017,11,15))

We may create a list of the dates (in serial number format) until the end of November, viz.

If we want the dates to look like dates, then we need more formatting options open to us.  Having created our list, if we want to transform data or 
merge with other tables, then we need to convert our list to a table, which is easy to do, as the options for lists are automatically displayed when 
we create the list.

As we have created a very simple list, we may take the defaults and create a table.  In the ‘Transform’ tab, we can choose to convert the ‘Data Type’ 
to ‘Date’ (we could also do this from the ‘Home’ tab).
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Thus, we have a list of dates in a recognisable format.

There are other ways to get a list of dates (without using the ellipsis).  The List.Dates function allows more flexibility:

List.Dates(start as date, count as number, step as duration) as list

We are going to create the list again from a blank query, using this function. 

=List.Dates(#date(2017,11,15), 16, #duration(1,0,0,0))

That sounds complicated: if only there were some way to remind us what to enter for the List.Dates function…

Now this is useful.  Power Query has recognised what we are trying to do when we enter List.Dates, and we may enter the parameters one at a time.

Now, since this function is more flexible, it looks more complicated.  We 
have specified the start date as before, then we need to specify how 
many list entries we want and finally, what the difference is between 

each entry.  Since we may also use this function for ‘datetimes’ the 
duration may be hours, minutes, etc.  Let’s choose to increment by one 
day at a time.  
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Let’s enter the parameters (enter one [1] as the step or increment as we’ll assume one day is the default).

The advantage this way, is that the dates are created in a recognisable format so we can see they are all there.  

There are some other interesting uses of the List functionality too.  We can list numbers, without using an ellipsis, and by specifying the interval:

List.Numbers(start as number, count as number, optional increment as nullable number) as { Number }  

This function is very flexible too, although it looks complicated.  Let’s create a list with the following formula:

= List.Numbers(3, 16, 3)

Therefore, we are expecting our list to start at three (3), have 16 entries and have an interval or increment of three (3).  As before, we don’t have to 
remember how to use the parameters; we can just enter List.Numbers:

We are now expecting to see our three times table:
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We don’t have to stick to whole numbers; if we choose different parameters we can have a list of decimals:

This time we should expect to see our 0.3 times table!

If for some reason we want to see our list in reverse, this can be achieved as follows:

List.Reverse(list as list) as list  

The list can be created using any of the methods used so far, so we can create

= List.Reverse({1..15})
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We  can reverse our three times table:

Finally (for this month), we may create a repeating list of numbers, with List.Repeat:

List.Repeat(list as list, count as number) as list  

This repeats any list as many times as we want.  Therefore, we can repeat the first three entries of our three times table.

= List.Repeat(List.Numbers(3,3,3),3)

More next month!

Power BI, Windows 7 and .NET Announcements
It’s been almost nine months since support for Windows 7 ended (back on 14 January 2020).  To be fair, Windows 7 has been around for more than 10 
years, so perhaps it is time for us all to let it go and move on…
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This means that Power BI Desktop will support on 31 January 2021.  After 
that, Power BI Desktop will only be supported on Windows 8 and newer.  
Further, the January 2021 release of Power BI Desktop Optimized (sic) 
for Report Server will be supported as per the Modern Lifecycle Policy, 
i.e. supported until the next release (currently scheduled for May 2021), 
after which it will only receive security updates until January 2022, after 
which support will also stop.

Microsoft is also making a change to the version of .NET that is required 
to run Power BI Desktop.  Starting from the October release users will 
need to have .NET 4.6.2 or greater installed.  This is installed by default 
with Windows 10.  For older versions of Windows, the Power BI Desktop 
installer will launch the .NET installer for you.

Power BI Updates
We noticed that the usual Power BI Desktop updates announcement was 
later than usual (much to the consternation of our desktop publisher and 
printers!) and put it down to the upcoming Microsoft Ignite conference.  
But it turned out that wasn’t the case.  No, Microsoft has decided it’s 
time to consolidate all Power BI update announcements – and, well, that 
takes time.

Amalgamated highlights this month include a Preview of the Smart 
narratives visual which helps you quickly summarise visuals and reports 
by providing relevant out-of-the-box insights which is customisable.  

On the reporting side, several things are added, including the introduction 
of controls for the z-order of visuals, and searching for a workspace 
during publish.  For modelling, the enhanced dataset metadata that was 
previously in Preview is now Generally Available.  In Power BI Service, 
new capabilities have been introduced in the lineage view, updates to 
Analyze in Excel have been made and deployment pipelines are now 
Generally Available.

Check out the full update list (deep breath!):

Analytics

	 •	 Smart narratives (Preview)
	 •	Q&A now supports arithmetic operations

Reporting

	 •	Data point rectangle select for additional charts
	 •	Added general visual option to maintain layer order 
	 •	 Search for a workspace during Publish
	 •	 Total labels for stacked visuals
	 •	Mobile authoring enhancements:
	 	 	 o	 Bookmark pane is now available in the Mobile layout view
	 	 	 o	 New options: turn off gridlines and snap to grid

Mobile

	 •	 Improved navigation tree (iOS and Android)
	 •	 Share from Power BI using your favourite apps (iOS and Android)
	 •	 Pinch and zoom is now available in all report views – on both 	 	
	 	 phones and tablets (iOS and Android)
	 •	Auto play a slideshow on start-up (Windows)

Service

	 •	New capabilities in Lineage view:
	 	 	 o	 Search within lineage view
	 	 	 o	 Data source impact analysis
	 •	 Excel inherits the Power BI dataset’s sensitivity label when using a 	
	 	 PivotTable connection
	 •	Analyze in Excel provides Excel file instead of .ODC
	 •	Deployment pipelines is now Generally Available
	 •	New simplified action bar
	 •	 Page navigation settings

	

	 	
	 •	Minimise global navigation and collapse left page navigation
	 •	 Tenant early opt-in and release plan
	 •	 ‘Other’ improvements

Modelling

	 •	 Enhanced Dataset Metadata is now Generally Available
	 •	 Performance improvements to aggregation expressions involving 	
	 	 columns of currency data type

Data connectivity

	 •	 CDS connector (Preview)
	 •	Azure Databricks
	 •	MariaDB
	 •	Hexagon PPM Smart API
	 •	Other data connectivity updates

Community

	 •	 Spanish language community forum is now available
	 •	Data Stories Gallery theme for October

Visualisations

	 •	 Collage by CloudScope
	 •	Advanced Trellis / Small Multiples Chart by xViz
	 •	Waterfall Chart by xViz

Template Apps

	 •	Multichannel Attribution Dashboard
	 •	Workspace Analytics Dashboard.

Let’s take a look at each in turn.

Smart narratives (Preview)

Frequently, users will use PowerPoint, text boxes, interactive headers 
or custom visuals to add narrative to their data.  All these options 
either lack interactive data, interactive and customisable text or useful 
automatic insights.  This Preview of Smart narrative visual can help users 

with this.  The Smart narrative visualisation helps you quickly summarise 
visuals and reports by providing relevant out-of-the-box insights in a 
customisable fashion.
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Using this feature creators can add narratives to their report to address 
key takeaways, point out trends, and edit the language and format it to 
fit a specific audience.  Instead of pasting a screenshot of their report 
in PowerPoint with key takeaways added, you may now add narratives 
to the report that are updated with every refresh.  End-users may use 

the narratives to understand their data, get to the key points faster and 
explain the data to others.

Since this feature is in Preview, you will need to first turn on the feature 
switch by going to File -> Options and Settings -> Options -> Preview 
feature and make sure ‘Smart narrative visual’ is turned on:

Clicking on the new smart narratives icon in the Visualization pane creates narrative based upon all the visuals on the page.
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You can also right click a visual and select ‘summarize’. This will generate 
an automatic summary of that visualisation.  For example, Power BI 
analyses the scatter chart visual showing the various transactions and 

shows which city / region has the highest revenue per transaction and 
highest number of transactions:
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The summary is highly customisable, where you can add new text, or edit the existing text using the same controls available in the regular text box.

You can also customise the summary by adding dynamic values.  You can map text to existing fields and measures or use natural language to define 
new measure to map to text.

The summary is dynamic and automatically updates the generated text and dynamic values when you cross filter.

Our clients have been crying out for something like this.  This could be quite amazing.

Q&A now supports arithmetic operations

Finally – Q&A now supports the following arithmetic operations:

	 •	Addition (+)
	 •	 Subtraction (-)
	 •	Division (/)
	 •	Multiplication (*)

Welcome to the 16th century!  This new feature is useful if want to ask questions that require a mathematical expression, such as adding measures 
together or multiplying a measure by a scalar value.
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To enforce a specific order of operations, you can use an open and closed parentheses:

It will revolutionise brackets…

Data point rectangle select for additional charts

Added general visual option to maintain layer order 

Last month, Microsoft released the Preview version of data point rectangle select, making it available for line, area and scatter charts.  This update 
sees it extended to the bar and combo charts.  Now you can draw a rectangle to select data points on the stacked bar / column, clustered bar / 
column, 100% stacked bar / column, line and stacked column, and line and clustered column charts too.

This is a Preview feature, so remember to go to the ‘Preview features’ section of the Options menu to enable it.

Typically, when you select an object on the canvas, it will be automatically 
brought to the front, above other overlapping visuals.  Clicking away 
from it will return it to its original position.  While this behaviour is 
intended and necessary (for example, to allow access to header menus), 
sometimes you would like an object, like a shape or background image, 

to stay in the background even when you accidentally click on them 
while viewing a report.

Now you can set any visual to stay in place rather than being brought to 
front upon selection: just turn on the ‘Maintain layer order’ toggle for 
that visual in the General card of the Formatting pane.

This will only adjust the behaviour for the Reading view.
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Search for a workspace during Publish

This update allows you to now search your list of 
available workspaces during the publishing process.  
This has been a long time coming!  After entering the 
Publishing dialog, you will now see a search bar at the 
top of your list of available workspaces that will allow 
you to filter them.

Total labels for stacked visuals

You can now turn on total labels for your stacked 
bar / column, stacked area, and line and stacked 
column charts, allowing you to see the aggregates 
of your data at a glance:

If your chart has a field in the Legend (for stacked bar / column) or Column Series (for 
combo) field well, you can enable ‘Total labels’ in its card within the Formatting pane:
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You will also be able to format the text of the labels, show a background 
colour around them (for example, to provide contrast with the visual 
background), adjust their transparency, and decide if you would like to 

sum the positive and negative values of your columns separately (that 
last feature will prove quite useful).

Mobile authoring enhancements

Improved navigation tree (iOS and Android)

Share from Power BI using your favourite apps (iOS and Android)

Mobile authoring has had some improvements this month too.

BOOKMARK PANE IS NOW AVAILABLE IN THE MOBILE LAYOUT VIEW

Starting with this release, when you are working on your mobile optimised layout using the Mobile view you can open the Bookmark pane and select 
a bookmark to see how it impacts the report in the mobile layout, without the need to go back to the Web view.

Now you can get around your content quickly and easily with a new 
navigation tree, available from the header drop down in reports, 
dashboards and apps.  You can see the location hierarchy of your content 
at a glance, and you can easily navigate up the content hierarchy, go to 

sibling content, or even get quickly back to your home page.  If the item 
you are viewing is part of an app, the tree displays the entire contents of 
the app: sections, links and all reports / dashboards.  If the item you are 
viewing is a report, you’ll also find a list of all visible report pages.  

This update allows you to share links to Power BI content with your 
contacts.  You can use the new share action in the header to send 
the link, using any collaboration app you have on your device, such as 

Microsoft Teams, a mail app, etc.  The link captures the current view, so 
you can even share filtered report views.

NEW OPTIONS: TURN OFF GRIDLINES AND SNAP TO GRID

Microsoft has introduced a new option to remove the gridlines from the canvas, so you may view the report without the square boxes – just like it 
will look on a real phone.  You can also remove the ‘Snap to grid’ constraint when designing the mobile optimised layout.  This will let you create a 
pixel perfect report, since you can place visuals anywhere on the canvas.
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Pinch and zoom is now available in all report views – on both phones and tablets (iOS and Android)

Auto play a slideshow on start-up (Windows)

New capabilities in Lineage view

Pinch and zoom is now enabled in all Report views, making it easier for you to zoom in and out of your report content, whether you are on your 
phone or on your tablet.

You can choose a report to automatically play in a slideshow when the Power BI Windows app is launched.  This is useful for creating a kiosk-like 
experience that runs a report in public displays without any manual intervention.

Microsoft has introduced search within Lineage view to improve 
productivity while using this view.  With the new search box, you can 
search across all the content in your workspace, quickly find items in 
the graph, view their lineage, and explore their metadata by clicking on 
the card.

To use the search, either type CTRL + F on the keyboard or click the 
search box on the top menu.  Use keyboard ENTER or a mouse click to 
move to the next search result.

When you search in Lineage view, you can find what you’re looking for 
by searching for the artefact name (e.g. Sales report).  You can also find 
it by typing any detail that is displayed on the card itself, for example, 
data source type and connection details, external workspace name and 
gateway.

A few months ago, dataset impact analysis was introduced.  Now, this 
update has released data source impact analysis.  With one click, you 
may now check which datasets and dataflows across the whole Power BI 
tenant use a specific data source.

For example:

	 1.		When a data source (e.g. an SQL database) is temporarily or 		
			  permanently taken offline, and you want to get an idea about 		
			  who is impacted

	 2.		When you build a certified dataset or dataflow that gets data 		
			   from a specific data source (e.g. a CSV file in Azure Blob storage) 	
			   and you want everyone who uses this data source to start using 	

your certified dataset rather than other datasets that use the 		
same source.  By eliminating dataset redundancy in this way, you:

		  o	 reduce the load on both Power BI and the source system
		  o	 create a single version of the truth and a single model that 		
				    has to be maintained.

Once you see the lineage between the data source and the datasets 
and dataflows that are built on top of it, the next step in some cases 
is to contact the dataset and dataflow owners.  With Notify-Contacts, 
data source owners can let dataset and dataflow owners know about 
problems or changes in the data-source.  Notify-Contacts can be also 
used to ask dataset and dataflow owners to stop using a certain data 
source and to use instead a certified or promoted dataset or dataflow.

Two new features to mention here.

SEARCH WITHIN LINEAGE VIEW

DATA SOURCE IMPACT ANALYSIS
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Excel inherits the Power BI dataset’s sensitivity label when using a PivotTable connection

Analyze in Excel provides Excel file instead of .ODC

Deployment pipelines is now Generally Available

Page navigation settings

New simplified Action Bar

Excel is very popular with Power BI users, especially for analysing Power BI data using a PivotTable.  This update now extends sensitivity label 
inheritance from Power BI to Excel files to include the PivotTable connection; a sensitivity label applied on a Power BI dataset will automatically be 
applied on the Excel file when you create a PivotTable in Excel.

Now, when you click on ‘Analyze in Excel’ in the Power BI Service, it will download an Excel file that includes a PivotTable connection to the Power BI 
dataset, instead of the .ODC file that was used until now.  This makes it easier to use straightaway.

Deployment pipelines allows content creators to improve Power BI content publishing efficiency and accuracy by moving it through development, 
test and production environments.  Next to making them Generally Available, this release includes support in incremental refresh, government 
clouds availability and improved user experiences.

Report authors can choose where the report page navigation sits, on the left, as a pane, or across the bottom, as tabs.  Go to File -> Settings and find 
the setting under ‘Pages pane’.

The “new look” is already rolling out; it is envisaged all users will have 
access to it by September 25, 2020 – that is, before this newsletter has 
come out!

The Action Bar has been made simpler and has now been organised so that 
it is easier to find related actions and putting most common actions in the 
foreground.  These have been updated for both reports and dashboards.

If the label on the dataset later changes to a more restrictive one, the 
label applied on the Excel file will automatically update upon data refresh 
in Excel.  If the dataset’s sensitivity label is less restrictive than the 
Excel file’s sensitivity label, no label inheritance or update takes place.  
Sensitivity labels in Excel that were manually set are not automatically 

overwritten by the dataset’s label.  If Excel file has a manually set label, a 
policy tip will show with a recommendation to upgrade the label.

This feature is available for customers with Microsoft 365 E3 and above.
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Minimise global navigation and collapse left page navigation

Tenant early opt-in and release plan

To give end users more room to view and interact with their reports, 
Microsoft has updated interactions to minimise the global navigation 
and collapse the left pages navigation.  Clicking the global navigation 
‘hamburger’ icon will minimise the navigation pane to just show the 

navigation icons.  When using the left page navigation within reports (as 
opposed to bottom tabs), clicking the pages icon arrows will collapse the 
navigation completely, so end users have more room to interact with 
content.  The interaction is now similar to Power BI apps.

By the end of September, the updates mentioned above will appear for users who have set the ‘new look on’.

Further, around the same time, a tenant administration setting will appear in the Admin portal under ‘Tenant settings’ that will allow tenant 
administrators to switch all users to the ‘new look’ and remove the old and new look toggle from the header. 
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At the end of October, all tenants and users will be moved to the ‘new look’ and the user-facing toggle will be removed from the header.  

‘Other’ improvements

Enhanced Dataset Metadata is now Generally Available

Performance improvements to aggregation expressions involving columns of currency data type

CDS connector (Preview)

Here’s a recap of all the existing ‘new look’ improvements:

	 •	New workspaces: easier to scan, find what you need, get data, search, take quick actions, and more
	 •	Updated personal bookmarks: previously, selecting a personal bookmark would update the bread crumb in the top bar with the name of the 	
		  bookmark.  Moving forward, the bookmark name will be updated inline within the context of the Report Action bar
	 •	View report details: see details such as last refresh date and contact information quickly, right in the top banner
	 •	Vertical list of pages: report page names are now in a list in a vertical pane.  They are now more prominent, harder to miss and similar to the 	
		  navigation features in Word and PowerPoint
	 •	 Improved filter experience: updates such as viewing applied filters and the new Filters pane are available by default with the ‘new look’
	 •	Dashboard experience: dashboards also have a simplified Action bar, just like reports and apps, for a consistent experience, while retaining 	
		  the functional differences.

Enhanced dataset metadata is now Generally Available.  In the past, only 
loadable queries generated in Power Query were mapped to the data 
model.  Now, all queries will be mapped to objects in the data model, 

and the queries will be regenerated based off of the data model upon 
opening of that PBIX.  This backend update has helped unlock future 
features improvements and will continue to do so in the future.

Microsoft has now improved the performance of aggregations over expressions that reference columns of the ‘currency’ data type over large 
imported tables, e.g. 

SUMX(Sales, [Sales Amount] * [Discount Rate]),

by pushing more calculations to the Vertipaq Engine.

There is a new connector for CDS in Power BI is going into public Beta.  
With this new connector, Power BI users have more options when 
connecting to Common Data Services (CDS) environments.  It should be 
noted that due to a previous deployment error, some Power BI August 
Desktop users may have seen this connector but were unable to use it.

This connector uses the Tabular Data Stream endpoint for the Common 
Data Service environment.  This endpoint enables better relationship 

discovery in the Power BI dataset model.  In addition, complex data 
types, such as lookups, option sets and currency are flattened for easy 
consumption in the model.

To make sure that you’re using the new connector, choose the Common 
Data Service (Beta) connector in ‘Get Data’ in Power BI Desktop, under 
the ‘Power Platform’ category.

For example:

	 •	With the addition of external tools in Power BI Desktop (which is currently in Preview), tables added through these external tools will now 	
		  appear as queries once you reopen your report

	 •	 For those of you who have tried exporting a PBIT and unzipping the file, you’ll now see the model in JSON and will no longer get errors about 	
		  corrupted files.

Keep in mind that if you have an older PBIX that cannot be automatically updated for reasons such as unapplied changes, you’ll need to successfully 
upgrade your model before you can make any additional modelling changes.
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Azure Databricks

MariaDB

Hexagon PPM Smart API

Other data connectivity updates

Spanish language community forum is now available

Data Stories Gallery theme for October

Azure Databricks is an Apache Spark-based analytics platform optimised 
for the Microsoft Azure cloud services platform.  Designed with the 
founders of Apache Spark, Databricks is integrated with Azure to provide 
one-click setup, streamlined workflows, and an interactive workspace 
that enables collaboration between data scientists, data engineers and 
business analysts.

Azure Databricks is a collaborative Apache Spark-based analytics service.  
For a big data pipeline, the data (raw or structured) is ingested into Azure 
through Azure Data Factory in batches, or streamed near real-time using 

Kafka, Event Hub or IoT Hub.  This data lands in a data lake for long term 
persisted storage, in Azure Blob Storage or Azure Data Lake Storage.  As 
part of users’ analytics workflow, they may use Azure Databricks to read 
data from multiple data sources such as Azure Blob Storage, Azure Data 
Lake Storage, Azure Cosmos DB or Azure SQL Data Warehouse and turn 
it into breakthrough insights using Spark.

This connector will be available in the Azure section of the ‘Get data’ 
dialog.

MariaDB Platform is a complete enterprise open source database 
solution.  It has the versatility to support transactional, analytical and 
hybrid workloads as well as relational, JSON and hybrid data models.  
It has the scalability to grow from standalone databases and data 
warehouses to fully distributed SQL for executing millions of transactions 
per second and performing interactive, ad hoc analytics on billions of 

rows.  MariaDB can be deployed on prem on commodity hardware, is 
available on all major public clouds and through MariaDB SkySQL as a 
fully managed cloud database.

This connector will be available in the Database section of the ‘Get data’ 
dialog.

Intergraph Smart® APIs (application programming interfaces) are RESTful 
OData web APIs developed by Hexagon PPM.  These APIs provide 
access to data associated with Intergraph Smart® 2D, 3D, Information 
Management and Materials software applications.  The Hexagon PPM 
Smart API Connector enables Microsoft’s analytics and visualisations to 

be applied to real time and historical data, associated with applications 
hosted in Intergraph Smart Cloud or on-premises.

This connector will be available in the Other section of the ‘Get data’ 
dialog.

There is always more:

	 •	Dremio has added support for .PBIDS files, and to enable users to connect to Power BI from within Dremio
	 •	 Kongsberg Vessel Insights has added support for fleet based queries or queries containing wildcards
	 •	Azure Time Series Insights includes bug fixes for column types shown in the response.

Power BI now has a Spanish speaking community forum!  If Spanish is your native tongue, you might want to check it out to learn all things Power 
BI en español.

Talking of Power BI communities, if you have not already connected 
with Microsoft’s Power BI community, you might want to check it out 
and make useful contacts.  Each month, community members post in 

the Data Stories Gallery and October’s theme is particularly relevant: 
“Power BI and Excel go better together”.  Apparently, there are some 
prizes available…

Collage by CloudScope

Collage displays images in the style of popular social networks, using either a grid or detail display:
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You can display images in either a compact grid display or a larger detail view in a style similar to Instagram.

To display an image, you provide a URL. In addition to the image url, you can optionally display any of the following field types:

	 •	 Caption
	 •	Media date
	 •	Media type
	 •	Video url
	 •	 Comment count
	 •	 Like count
	 •	 Permalink
	 •	Author profile image
	 •	Author name
	 •	Caption sentiment.

In addition, you can provide any generic data fields that you wish 
(number, true / false, date, string).  These data elements will be 
automatically formatted in the familiar Instagram style for numbers and 
dates.  Some of the above fields are only shown in the detail view.

Collage can act as a filter to other visuals within your report.  It also fully 
supports the Power BI bookmark feature and may be downloaded from 
AppSource.

Advanced Trellis / Small Multiples Chart by xViz

Waterfall Chart by xViz

xViz has released a new version (1.1.4) of the xViz Advanced Trellis chart 
(also known as small multiples) with several new chart types, features 
and an improved user experience.  More than 10 new chart options 
have been added with dedicated Styling and Data Label sections to style 
each chart individually.  There is also an improved chart readability with 
additional layout options, such as  Row scale and Top/Bottom ‘N’ ranking 
on a chart level to focus on key drivers.

Business end users can now search and pin panels and visualise 
outliers quickly with additional conditional formatting options for chart 
background and titles.  The Animated section has been updated with 
Animated title, Speed (delay), and new styling and formatting options.

xViz has also released a new PBI Certified version (1.1.5) of the Waterfall 
Chart, which now supports the commonly requested idea place request 
for Stacked Waterfall chart option and ‘Only values waterfall’ along with 
existing use cases of Variance & breakdown analysis.

There is also a new Ranking feature to help users focus on the most 

important categories and group the remaining items into ‘Others’.  
Further enhancements include an improved deviation bar and sorting 
options, together with data point annotations features.

And guess what?  This visual may be downloaded from AppSource.

Again, this visual may be downloaded from AppSource.
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Multichannel Attribution Dashboard

The Multichannel Attribution Dashboard by Windsor.ai helps performance 
marketers to visualise and connect all their performance marketing data 
across all media, analytics and CRM.  It contains integrations to Google 
Analytics, Google Ads, Facebook Ads, LinkedIn Ads and Bing Ads which 
automatically refresh data to ensure data freshness.  The connected data 

is modelled using a data driven attribution model to provide insights on 
how to improve marketing performance.

This template app has a visually rich report page with filters for 
performance marketers to get a summary on how marketing campaigns 
are contributing towards marketing and business goals.

To connect data, you need a Windsor.ai account.  
Once registered and logged in, you may connect your 
data on the onboarding page:

	 •	Google Analytics
	 •	Google Ads (optional)
	 •	Bing/Microsoft Ads (optional)
	 •	 Facebook Ads (optional)
	 •	 LinkedIn Ads (optional)
	 •	 Salesforce, Hubspot, Dynamics CRM (optional).

mailto:contact@sumproduct.com
http://www.sumproduct.com


contact@sumproduct.com  | www.sumproduct.com  | +61 3 9020 2071 

Workspace Analytics Dashboard

In the current world lockdown environment, as employees move to working remotely (get it?) and collaboration becomes digital, employee support 
becomes even more important.  The Workspace Analytics Dashboard by Data Maru can help answer the following questions:

	 •	Are collaboration hours changing significantly as collaboration becomes digital?
	 •	How are external network managed as employees move to remote work?
	 •	How do employees adopt Microsoft Teams?
	 •	Are employees collaborating in different ways?
	 •	Can Teams channels replace scheduled meetings?
	 •	Are employees working after-hours?

It sounds like some sort of spying software, but that’s not what it is.

To connect data, before you can connect the Workplace Analytics dashboard, you must:

	 •	 Be assigned the role of Analyst in Workplace Analytics
	 •	 Run predefined queries in Workplace Analytics: Standard person query and Teams Insights.

Then:

	 1.	Log into PowerBI.com and go to Apps and select ‘Workplace Analytics Dashboard’.  If you haven’t installed it, search Workplace Analytics 	
		  Dashboard from AppSource and install it first

	 2.	Enter the URL of OData link required for both the Standard person query and the Teams Insights query
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	 3.	For the Standard person query, sign in with an account logged into Workplace Analytics.  Choose ‘Microsoft account’ for Authentication 	
	 	 method and ‘Organizational’ for the Privacy level setting

	 4.	For the Teams Insights query, sign in with an account logged into Workplace Analytics.  Choose ‘Microsoft account’ for Authentication 	
	 	 method and ‘Organizational’ for  the Privacy level setting once more.

This may also be downloaded from AppSource.

That’s it for this month – more next month, we’re sure!

The A to Z of Excel Functions: FACT
In mathematics, the factorial of a non-negative integer n, denoted by n!, is the product of all positive integers less than or equal to n. For example, 

5! = 5 × 4 × 3 × 2 × 1 = 120.

The value of 0! is 1, according to the convention for what is known as an empty product, being the multiplicative identity (just as zero (0) is the 
additive identity). 

The factorial operation is encountered in many areas of mathematics, notably in combinatorics, algebra, and mathematical analysis. Its most basic 
occurrence is the fact that there are n! ways to arrange n distinct objects into a sequence.  These arrangements are called the permutations of the 
set of objects.  

These numbers become astronomical (technical term) very quickly.  

In FACT, Excel has a function, FACT, which calculates these factorials and has the following syntax:

FACT(number).

The FACT function has the following arguments:

	 •	number: this is required and is a non-negative number for which you require the factorial.  

It should be further noted that: 

	 •	 if number is not an integer, it is truncated
	 •	 the factorial of a negative number returns a #NUM! error
	 •	 the largest allowed positive number (which has to be calculated rather than input) is 1.7976931348623158 x 10308 (also denoted as 		
		  1.79769E+308).  171! is larger than this upper bound and hence 171! or any higher value will return a #NUM! error.

Please see the example below: 
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Let’s take a closer look at the FACT function:

Similarly:

	 •	 22! is actually 1,124,000,727,777,607,680,000, which is displayed by default as 1.124E+21 and is stored as 1.12400072777761E+21.  This 	
	 	 stored string has 20 characters: 15 digits (the maximum significant figures Excel can display), a decimal point and four characters for “E+21”.  	
	 	 This means that the maximum length for a number smaller than 10100 is 20 characters

	 •	 23! is actually 25,852,016,738,884,976,640,000, which is displayed by default as 2.5852E+22 and is stored as 2.5852016738885E+22.  This 	
	 	 stored string has 19 characters.  This time only 14 digits are included: this is because the 15th number would be “0” and hence is suppressed.   	
	 	 This is why 23! has a length of 19 rather than 22! which has a length of 20.  23! is definitely larger than 22!

Therefore, precision is of concern with larger numbers in Excel as they will only display to a maximum of 15 significant figures.

There are two more issues though.

Firstly, let’s take a look at 171!

Do you see what happens from FACT(15) onwards?  These numbers are 
expressed – and more importantly, stored – in Scientific (Exponential) 
notation.  15! is actually 1,307,674,368,000, although it is displayed as 

1.30767E+12 and is stored as 1307674368000 (deliberately no commas), 
which is why its length is 13 (there are 13 digits – more precisely, 
characters – in the text string).

mailto:contact@sumproduct.com
http://www.sumproduct.com


contact@sumproduct.com  | www.sumproduct.com  | +61 3 9020 2071 

It’s the first number in the sequence Excel cannot calculate.  The #NUM! 
error is well earned.  The largest allowed positive number (which has 
to be calculated rather than input) is 1.7976931348623158 x 10308 (also 
denoted as 1.79769E+308).  171! is larger than this upper bound.

Secondly, I note using numbers only will not retain precision.  I need 
to convert the number to text so that Excel will store all the characters 
(that’s OK – the maximum number of characters allowed in one cell is 

32,767 if I link it in from a closed workbook).  The problem is, many Excel 
functions – including most of the useful text manipulation functions, 
such as LEFT, RIGHT and LEN will only work with a maximum of 255 
characters.

To solve the challenge, you need to get creative and I will demonstrate 
this by calculating 171!, which is (big drum roll please)…

This is a screenshot from an Excel workbook which calculates 171! As 1,241,018,070,217,667,823,424,840,524,103,103,992,616,605,577,501,693,18
5,388,951,803,611,996,075,221,691,752,992,751,978,120,487,585,576,464,959,501,670,387,052,809,889,858,690,710,767,331,242,032,218,484,3
64,310,473,577,889,968,548,278,290,754,541,561,964,852,153,468,318,044,293,239,598,173,696,899,657,235,903,947,616,152,278,558,180,061,
176,365,108,428,800,000,000,000,000,000,000,000,000,000,000,000,000,000 – only without the commas!

How was this achieved?  Without any VBA, I created a table in Excel to calculate the following:

	 1.	 I need to identify the largest factorial in my table (171) and multiply this by 9.99999999999999… (rounded up to 10) to work out the 	
		  number of characters I need to keep in reserve, which is 171 x 10 which is 1710 (without commas).  This is four characters.  Given one 	
		  character is already used, I need to keep three characters in reserve (this is used for the next step)
	 2.	 Since the maximum number of significant figures is 15, I need to separate my number into blocks (what I called “batches” in the model) into 	
		  text strings of no more than 15 – 3 = 12 characters.  This was defined as the Batch_Length
	 3.	 Define 1! as 1
	 4.	 Convert 1! (1) to a text string (“1”)
	 5.	 Now we need to calculate the next factorial
	 6.	 Calculate the character length of this string
	 7.	 Divide this length by Batch_Length (i.e. 12) rounded up to the nearest whole number.  This is how many batches are needed
	 8.	 Split the text factorial into batches: Batch 1 is the final 12 characters, Batch 2 is the 24th from last to 13th from last digit, Batch 3 is the 36th 	
		  from last to the 25th from last digit, and so on
	 9.	 For each batch, convert the text string back to a number simply by multiplying by the factorial you are trying to calculate (e.g. if you have 	
		  just calculated 1! then multiply by two, if it is 17! then multiply by 18)
	 10.	 If the resulting number contains more than 12 characters, split the number in two: the “edited” number is the last 12 characters and the 	
		  “residual” is any digits at the beginning not included
	 11.	 Add the residual from Batch n-1 to the Edited number in Batch n
	 12.	 Convert all of the numbers back to text strings
	 13.	 Concatenate the batches using the ampersand (‘&’) operator (note this cannot be done with a text function because only 255 characters 	
		  are allowed and only 15 significant figures would be displayed)
	 14.	 This is the next factorial in the series
	 15.	 To calculate the next factorial in the sequence, return to Step 5 (above).

	 •	 Even when you encounter a limitation in Excel, where there’s a will there’s a way (and often a relative too)
	 •	 You need to be mindful of the degree of precision in Excel’s outputs (only 15 significant figures)
	 •	 Larger numbers may not be manipulable using Excel’s built-in functions
	 •	 Factorials (even large ones) are often used in combinatoric problems, such as selecting a subset x from a larger set y.  Given x and y, the 	
	 	 solution Excel may give may not be quite correct.  This is why many statisticians often use software other than Excel. 

This is more complicated than it sounds (and it sounds complicated!) due 
to having to consider what happens if a batch in the middle of the text 
string starts with one or more zeros, for example.  For those who would 
like to know more (or simply suffer with insomnia), please review the 
table in the Excel file.

You might think, “who cares about 171 factorial?” and you may have 
a point.  However, this simple question has a non-trivial solution and 
highlights key issues that need to be considered when with large 
computations and / or numbers:

The A to Z of Excel Functions: FACTDOUBLE
Once voted the most useless function ever in Excel, chances are you have never used the FACTDOUBLE function – and you are exceedingly unlikely 
to do so in the future too.  This function, denoted n!! for FACTDOUBLE(n), returns the double factorial of a number.
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The FACTDOUBLE function employs the following syntax to operate:

FACTDOUBLE(number)

The FACTDOUBLE function has the following argument:

	 •	number: this is required and is a non-negative number for which you require the factorial.  

It should be further noted that: 

	 •	 if number is not an integer, it is truncated
	 •	 the factorial of a negative number less than -1 returns a #NUM! error (not sure why FACTDOUBLE (-1) equals 1)
	 •	 if number is even, n!! = n x (n – 2) x (n – 4) x … x 4 x 2
	 •	 if number is odd, n!! = n x (n – 2) x (n – 4) x … x 3 x 1
	 •	 the largest allowed positive number (which has to be calculated rather than input) is 1.7976931348623158 x 10308 (also denoted as 		
		  1.79769E+308).  301!! is larger than this upper bound and hence 301!! or any higher value will return a #NUM! error.

We understand it may be useful for working out the odds of winning in poker…

Please see our example below: 

More Excel Functions next month…

Beat the Boredom Suggested Solution
As mentioned earlier in the newsletter, in a recent financial model build, we needed to work out how much of a certain product was sold, which 
reduced each period, based on two multiplicative factors.  Over the life of the project, the proportion that needed to be considered was:

In Excel, I just needed to sum this as efficiently as possible¬ – returning the total as a fraction in its simplest form.

Therefore, the challenge was to create an Excel spreadsheet that can calculate the result and be sufficiently flexible to allow for alternative, similar 
sequences of varying length.  I stipulated you should not use dynamic arrays, VBA or megaformulae.  So how did you do?

Suggested Solution

Often under time pressure, we resort to becoming hapless automatons that simply crunch numbers without thought.  Yes, I could just add the 
numbers up constructing an Excel summation.  However, the spreadsheet would return a decimal such as

0.166333666333666…

which provides little insight.  Furthermore, I actually wanted the number expressed as a fraction.

It’s trivial to note that the numbers in the denominator were consecutive pairs in the sequence

2, 5, 8, 11, …, 998, 1001

i.e. the pairs were always a gap of three (3) apart (e.g. 5 – 2 = 3, 8 – 5 = 3, 1,001 – 998 = 3).

However, did you spot that

and, more generally,
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This is where readers who are parents may note their children might have helped!  The trouble is many of us learned fraction subtraction a lifetime 
ago and either (a) have long since forgotten it and / or (b) never understood it in the first place!

After this, the problem becomes straightforward:

You could create this automatically in a spreadsheet.

At this point some of you will state that they could have done this simply by formatting cells and choosing ‘Fraction’ for the result:

But that will not always work – like here.  If you did this with this month’s 
challenge you would have obtained 83/499 and not 333/2,002.  These 
two fractions are not equivalent.  Therefore, if you did this you would 
have calculated the wrong answer.  We need to work out the numerator 
and denominator in separate cells.

Even if you have done what I have done so far, there is still one more step.  
The fraction has to be in its simplest form, i.e. where the numerator and 
the denominator share no common divisor greater than one (1).  This 
may be achieved using Excel’s GCD function.

In mathematics, the greatest common divisor (GCD), also known as the 
greatest common denominator or the highest common factor, of two or 
more non-zero integers, is the largest positive integer that divides the 
numbers without a remainder. 

The Excel function GCD returns the greatest common divisor of two or 
more integers.  The greatest common divisor is the largest integer that 
divides both number1 and number2 without a remainder.  It has the 
following syntax: 

For example, the GCD of 333 and 2,002 is 1, so this is the simplest fraction.  However, if we extend our sequence to

Then the result is 

GCD(number1, [number2], ...)

This is because GCD(400,2404) equals four (4), 
so both the numerator and denominator may 
be quartered.
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Link to Others
These newsletters are not intended to be 
closely guarded secrets.  Please feel free 
to forward this newsletter to anyone you 
think might be interested in converting to 

“the SumProduct way”.

If you have received a forwarded 
newsletter and would like to receive 
future editions automatically, please 

subscribe by completing our newsletter 
registration process found at the foot of 
any www.sumproduct.com web page.

Any Questions?
If you have any tips, comments or queries 
for future newsletters, we’d be delighted 
to hear from you. Please drop us a line at 

newsletter@sumproduct.com.

Our Services
We have undertaken a vast array of 
assignments over the years, including:
· 	 Business planning
· 	 Building three-way integrated 		
	 financial statement projections
· 	 Independent expert reviews
· 	 Key driver analysis
· 	 Model reviews / audits for internal 	 	
	 and external purposes
· 	 M&A work
· 	 Model scoping
· 	 Power BI, Power Query & Power Pivot
· 	 Project finance
· 	 Real options analysis
· 	 Refinancing / restructuring
· 	 Strategic modelling
· 	 Valuations
· 	 Working capital management
If you require modelling assistance of any 
kind, please do not hesitate to contact us 
at contact@sumproduct.com.

Training
SumProduct offers a wide range of 
training courses, aimed at finance 
professionals and budding Excel experts. 
Courses include Excel Tricks & Tips, 
Financial Modelling 101, Introduction to 
Forecasting and M&A Modelling. 

Drop us a line at training@sumproduct.com 
for a copy of the brochure or download  
it directly from 
www.sumproduct.com/training.

Check out our 
more popular 
courses in 
our training 
brochure:

There are c.550 keyboard shortcuts in Excel.  For a comprehensive list, please download our Excel file at
www.sumproduct.com/thought/keyboard-shortcuts. Also, check out our new daily Excel Tip of the Day feature on the 
www.sumproduct.com homepage.

Key Strokes
Each newsletter, we’d like to introduce you to useful keystrokes you may or may not be aware of.  This month, we thought we bring 
CTRL to the FUNCTION keys…

Keystroke What it does
CTRL + F1 Show / hide Ribbon
CTRL + F2 Print
CTRL + F3 Open Name Manager
CTRL + F4 Close Window
CTRL + F5 Restore Window
CTRL + F6 Next Window / workbook

Keystroke What it does
CTRL + F7 Move Window
CTRL + F8 Size Window
CTRL + F9 Minimise Window
CTRL + F10 Toggle Maximised / Restored
CTRL + F11 Insert new Macro Sheet
CTRL + F12 Open
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Location Course Date Date Duration Duration

Online (Australia) Power Pivot, Power Query and Power BI 9 - 11 Nov 2020 09:00-17:00 AEDT (-1 day) 22:00-07:00 GMT 3 Days

Online (Australia) Excel Tips and Tricks 16 Nov 2020 09:00-17:00 AEDT (-1 day) 22:00-07:00 GMT 1 Day

Online (Australia) Financial Modelling 17 - 18 Nov 2020 09:00-17:00 AEDT (-1 day) 22:00-07:00 GMT 2 Days

Online (Australia) Power Pivot, Power Query and Power BI 14 - 16 Dec 2020 09:00-17:00 AEDT (-1 day) 22:00-07:00 GMT 3 Days

Upcoming SumProduct Training Courses - COVID-19 update
Due to the COVID-19 pandemic that is currently spreading around 
the globe, we are suspending our in-person courses until further 
notice.  However, to accommodate the new working-from-home 
dynamic, we are switching our public and in-house courses to 
an online delivery stream, presented via Microsoft Teams, with 
a live presenter running through the same course material, 
downloadable workbooks to complete the hands-on exercises 
during the training session, and a recording of the sessions for 

your use within 1 month for you to refer back to in the event 
of technical difficulties. To assist with the pacing and flow of 
the course, we will also have a moderator who will help answer 
questions during the course. 

If you're still not sure how this will work, please contact us at 
training@sumproduct.com and we'll be happy to walk you 
through the process.

Word to the Wise

Whether you took a similar approach, chose a more convoluted route or simply didn’t bother, do note that sometimes financial modelling is about 
thinking more simply.  It’s not always about who knows IFRS, the latest fancy functions in Excel or VBA, sometimes it’s simply a case of spotting 
there’s a wood in those trees.

Until next time.
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